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crossworel [Jlli-'-'f-ll: {or woril-cross s
he called it) [or the Christmas 1913 edition
ol the New York World. he couldn’t have
konown the impact his inspiration would
IIH.\"" rl .‘-I:ll:'i.l:"t :.'- .-\.rll‘r HI!I]l Wl Eﬂ :I.'l:"ﬂr‘."i |hf'
LT W rr\ll IFi“"IH RELRASELLNDY IlLI.:'.-I:I.-l. [-L'l.l‘ll""r:"lj
In fact, the erossword's populariry has in-
spired board games, television shows, and
other more (and less) sophisticated word
puzzles. In spite of these COTpettors, the
classic crossword puzzle sill remains the

#1 form of indoor entertamment.

Because of the popularity and growing
F'ﬂ."il"‘-'l'lf- | I “rfF'T'!"I"I |:'|'I|.' TINH !l"l'l'l 'I:'H"'r!'l-'l']l IH]
l'“‘fll!"]l‘l'r‘h- i I"“l'II"H' 1"'||'|.‘|il"|ll l!li.l[ it was
finally time to merge crossword puzzles
with this technology that has rapidly be-
core such a large part of our lives. The
initial challenge was 1o find a way 10 make
the computerized erossword experience as
accessible and easy-to-use as classic paper
and pencil erossword puzzles. Sierra’s
LakeeA9Break! line provided the perfect
oppoartunity. An entire soltware line dedi-
cated 10 pames vou can jump into any-
time you need a quick break from work.
sereaming children. or the evervday
insanity that imposes upon all our lives.

The next hurdle was how to make cross-
words even better on the computer than

O AT, After Hipliﬁi'ﬂl]l research and

1_||:5igr|. W Came up with several features
that we think make TakeedeBreak!

Crosswords easier and more fun to use
than traditional crosswords. Features like
an option that tells vou immediately if an
ATISWET 15 right OF Wrong and one that au-
tomatically highlighis the word vou're
working on so you don't lose vour place.
You can get a hint without waiting until
LRET II'_I‘]_']_'IL'I“'-‘_- l]l_"“'hpﬂlj["r O CUstormeE: 1 I'“"
|'|':H"ILT I:'I"F Thl" I"'I.III!"!- o =1t ':I.'”llr 1aste. \-"H
i Fl].‘i" IZ.I"I"FI‘ =TT Hll[i F]lil"l-' [i!lll"ll P R
in order to compete with your friends and
[amily. TakeedsBreak! Crosswords even
congratulates vou with an animation and
H Tl'l“E].\lEI'I' Ilrﬂ".'ﬂk'ill_g I'I'I'II:I"" ";l.'lH']'l ':f"!i
[inish a puzele—iry to ger vour Sunday
paper to do that!

Taken Ao Break! Crossivords }:lnn.'hl[*.-i Vil
with an original music soundrtrack that
merges modern jazz and rock & roll with
a classical. Bach-like feeling. Last, but
not least, we've ineluded a r]‘mnuing
animatied tour _:rll:iih' tor thies lagned oof
Crogsirords—Wanda the Word Fairy.

But that's enough from us, on 1w
more important business: playing
TakeeA*Break! Crosswords! Have
fun taking a break!!



he first newspaper in the United States to include crossword puzzles as a daily
feature was The New York World. Their first daily puzzle appeared on
November 24, 1924 and was composed by none other than Gelett Burgess, the author

of the following famous ditty: “| never sow a Purple Cow, | never hope to see one;

But | can tell you, l:!rT:.u"I"u;iW_ I'd rather see than be one”

Crosswords, or Word-Cross puzzles. as
thewy weere known in the hﬁﬂinlling- had

humble origins. Arthur Wynne of the New

York World was searching for a new tyvpe
of puzzle for the Christmas 1913 edition
of the World’s Sunday supplement.
Rebuses, hidden words and anagrams
were the usual fare, but he wanted some-
thing special. Playing with traditional
“'ﬂ'r‘lj 'I:I'll?;ﬂll’q. hF‘ ﬁn]rlihlr'ii '||l?"'[| t.l:“' i‘l ]ﬂ-‘l
of the word-cross puzele.

“'}'rmt‘s'[:lmhh&?n a phﬂmmrnun
that persists even tnﬂn].'. From its first

appearance. people were crazy for the
crossword. When the puzzle was dropped
from the paper one Sunday, the World

g overrun with rmnplﬂim:- from s

gers. With time, the crossword puezle
loped its [amiliar square grid with an
inumber of squares in all rows and
flitins. It hecame universally aceepied
th the diagram should be a mirror
image of itsell if divided diagonally

(it should look the same il turmed upside
down) and that all words must interlock.
The reasons behind the mirror-like sym-
metry of the puzzle are unclear, although
the legendary puzzle editor. Margaret

Fi‘lfri:l_f. WHs rl_"l_bl_.l_llflj (1] i'l],:l".'l" Sl ill 1]“” r|:]1‘
puzzle has adopted this form “because it
is prettier.”

Over the next ten years the crossword
puzzle craze continued 1o grow. While the
World was the first newspaper o get into
the act, Simon and Schuster came out
with the first book of crosswords in
January 1924, Initially mocked by their
peers in the publishing field, they pub-
lished the book under the psendonym.
The Plaza Publishing Company. Within
a day of publication, however, no one
was langhing as orders for the book
poured in. One year later the company
had published three volumes of pueeles
with record breaking (for 1924) sales of
over 400,000 copies.

Crossword puzele mania was here to stay,
Couples composed erosswords announc-
ing their engagement. Churches Fot mio
the act using crosswords o attract more
people to services, Even the fashiom in-
dustry was bitten by the crossword bug,
In 1925 the industry reported an in-
creased demand for checked fabrie, One
New York dress manufacturer even came
out with a line of dresses embroidered
Continued on page O



The World’s First Crossword

(answer on page 9
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What bargain hunters enjoy. 422, Whatwe all should be.
A written acknowledgement. 4-26. A day dream.
Such and nothing more 2-11.  Analen.
A bird, 19-28. A pigeon,
Opposed o less. 7. Paortof your heod.
What this puzzle is 23-30. A river in Russia
An animal of prey. 1:32. To govern.
The dose of o day 33-34.  An oromatic plont
To elude. n-8. A kst
The plurcl of is. 24-31.  Toogree with.
To cultivate, 3-12.  Portof o ship.
A bar of wood o iron. 20-29. One
What artisis learn o do. 527. Exchanging.
Fastened. 925 Tosink in mud
Found on the saashore. 13-21.  Aboy.
The fibre of the gomu# palm

10-18.




HISTORY AND TRIVIA

with puzzle squares. Each dress came with
a book of puzzles that. if returned 1o the
COMPany l'l.l'l'l'l'l"l:lu solved, camed the fash-
ionable puzzler a discount on other eloth-

ing in the line.

The play. Puzzles of 1923, leatured the
patients of a mental hospital solving cross-
word puzzles and became a Broadway Iat
in the 1920s. Another hit was Tefl Me
More! n Broadway musical thar contains
the line. "I hope vou're stranded on a
desert island with a erossword puzele and
without a dil'rilllliir'}'." \ Flﬂ[ml;-'lr SO of
the day was “Crossword Mama You Puzzle

Me (But Papa’s Gonna Figure You Owt).”

Sometimes crossword mania took on
strange and disturbing forms. An under-
taker’s trade journal featured a crossword
in their June 1925 issue that contained sci-
entific and technical terms about funerals
and embalming. A man named Theodore
koerner shor his wife for refusing to help
him with a puzzle and then killed himself.
[she survived the anack.) A waiter
from Budapest killed himself in
1926, leaving behind a sui-
cide note in the form of

H CTSSWOTT |

puzzle. The police were forced 1o call in
puzzle experts to help them solve it
T:'q'rlmp-a as a response o these unusual
evernls, Gelent Burgess was irl-Juirn-d Lor ot

[H"ll L JJﬂJ W A T

he tans they chew their penc
T il -

I NE ans -‘|'-':'-f' DECT Thedr wives
A I

They look up words tar extinct birds—

U-’

They lead such puzzling lives

Watching the phenomenon from abroad.
The Times newspaper in London pooh-
poohed America’s [ascination with eross-
word puzeles. Featured under the headline
“AN ENSLAVED AMERICA™ an article
about puzzling stated: “All America has
succumbed to the crossword puzzle.” Not
two muomths later the Times was forced 1o
eat those words when it realized thar
Britain. too. was enamored with the cross-
word puzzle. The Times referred 1o its
“Enslaved America™ article when it stated.
“The aceount was hardly printed before
the craze had crossed the Adlantic with the
speed of a metearological depression, The
nation stands belore the blast and no man

can sav it will stand erecr again,”

Fortunately, not evervone took such a dim
view of puzzling. In January 1932, The
Vew Fork Times was pleased 1o report tha
Buckingham Palace had issued a statement
that Queen Mary was a crossword enthusi-
ast, The Prime Minister of England also
turned out to be a puzzler. He praised the
crossword puzzle in a speech ar a Press

Clubs luncheon and seated thar the press



was bettering the common
peaple “through that marvelons
medium, the crossword puzzle,”

Leorge Dellacourte began his legendary
Dell Crossword Puzzle Magazine in 1931,
The eccentric New York benefactor left a
legacy thar includes 34 monthly puzzle
magazines published in all English-speak-
ing countries, A familiar sight 1o New
Yorkers, Dellacourte could often be seen
sporting a floppy hat and a long flowing
cape. During his lifetime Dellacourte
donated grear sums of money o various
deserving New York charities. His only
requirement was that his gift be acknowl-
edged by displaving his name in a promi-
nent public place. Today. stames and
plagques to Dellacourte abound in New
York city.

Crossword madoess continued imo the
Forties and Fifties. The New Vork Times
began publishing its now-famons Sunday
Htllllwuimhﬂb in 1942, The
smaller, uﬁrdﬂ! puzzles became a regu-
lar feature ﬁ’hm

In 1944, thmm'-r for the London
ﬂm-‘}*fwm:d Sidney Dawe.

came under close serutiny from British in-
telligence officers when his puzzles started
comtaining solutions that matched secret
codde names for landing beaches in the up-
coming invasion of Normandy! Somehow
Dawe convineed the military that it was all
a fantastic coincidence,

In more recent crossword history, Merl
Regale, whose puzzles regularly appear
in the San Francisco Eraminer. composed
a SPE"G.IIH]. E.I‘“IIII:' rnr il I":-'!I] rl;'l.l'l‘.. .\:Ei]_
Nathanson. The puzzle. which appeared
in the Sunday Eraminer in November
1991, contained a marriage proposal
from Neil 1o his beloved, Leslie Hamilion

—"Dear Leslie, will vou marry me? Neil.”

The First Lady of Crosswords |
Fresh from Smith College in e
Margaret Petherbridge’'s first job .
secretary o the editor of the New Fork
World s magazine section. Among oth
things, her duties included making sur
that the wwlclf crossword pl.tmlﬁa Elpe-
peared without typegraphical errors,
Petherbridge was so adept at sporting
mistakes that she became the mnofficial
crossword editor. When Simon and
schuster published their first puzzle book
they sought out Petherbridge’s expertize
and she worked as their editor as well.
She became Margaret Farrar in 1926,
after her ma rriage to publisher John
Farrar. In 1970, she celebrated the 100th
volume of Simon and Schuster eross-
waords under her editorship. When the
New York Times began offering regular
puzzles in 1942, they. too, hired Margaret
FFarrar as their puzele editor.

As the undisputed “Queen of Puzzle-
dom.” Farrar's career has been long and
distinguished. While compiling a book of
crosswords by celebrities early in her ca-



HISTORY AND TRIVIA

reer with Sumon and Schuster, she received
the following reply to a request for a sub-
mission from playwright and novelist Booth
TurLEl:_;-:lug]:

Wy decer Miss Petherbridae:

I freree Feeaed Proseifele l_l' et le vioder B

g I I 5 -l

i kiriel .'I'- dirtedd Fo iln i,

' '-'.".'lll"ll. i _||_._.., i

FiRE T fy af e send me Flee forsd Dok presi

. .
1% 1 ks celeoded B ol gone arerdioee ok,

II'||'||.-.|. PR 1 Il |'I.'..'|.l-.'I FLAd .':|'-

157 |.-'_I i frrst he genf mee Hie se
wried, -'-".'--n'.'_-."- I freaeed worrften b, heggino

Ficerr poasd By idin £t

Wi I o I YiIbauT i1 llln'.l e fieh

foinenr o '.'l_l"'."n.'r.-'_- e erlpoasd L F it |l

. I I
e erery K,

Welisrvorntiv: Vorrars

Footh Tarkinelon

Farrar once received a
call from a student ar
Columbia Universiny
asking for help on
that ri:r!."-'- CTES-
word as it was

a Jm*n'qui-

site for admission in a certain CHIIIS
fraternity. She recognized the ethical
dilemma but threw him a few hinis and
Jl(l'l :l!"ll IIIIT lIIr_' I'_'Il_‘h'.

Farrar established her own eriteria for
what made an aceeprable puzele, Her
most important requisite was that the
solver musi enjoyv working the puzzle.
Tha l1lg|l crossword aficionados sull 1’|||jh-
ble about the details. Farrar s criteria sull
stand as a guide for puzzle designers to-
dav. Aceording to Farrar's guidelines. all
parts of the puzele must connect with all
other parts with ne unchecked letiers.
Black squares can account for no more
than 1/6 of the toral squares in a puzzle.
She did not allow: TI."l:l-IF‘I't-E.‘I words and

|L||1. I:III1I|!' to death in t'ru--mtr|| [ " lie: :
"

over the vears) like “gnu™ are 11}&-21‘r bae

avoided as are obscure foreign wor

inelegant abbreviations.

Successors to the Throne

Murgaret Farrar was succeeded ar The
New York Times in 1969 by Will Weng,
former head of the Times metropolitan
COpY desk. While serving as Illl?.?:ll" ealitor
he popularized a new sort of puzzle with
a humorous bent, An avid punster, Weng
aecepted many puzzles with clies or solu-
tions that formed humorous puns. In one

'I'lj. m-f'll:_".h LWL !HJIIII‘h IIIII l'I'II!". Ih YT




docror influential¥™ resulted in the answer Dr. Eugene Maleska. poet and former su-
“NOBUT MY DENTIST HAS A PULL.” perintendent of east Bronx schools in New
Sometimes the puns or gimmicks weren' York. succeeded Weng in 1977, Maleska
s0 obvious and resulted in much com- continues Weng's humorous puzzle legacy
plaining from disgruntled readers. For in- and has introduced some of his own pue-
stance. the -im]1|r cloe “AVT” led to the ele inventions incorporating famons
answer: “THE. CENTER OF GRAVITY™ quotes, He is also responsible for repopu-
and howls of protest from many puzzlers larizing the cryptic crossword in the

Linited =tates

Solution to puzzle on page 5
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Installation
1. Enter Windows by tvping “WINT at the
D= prompt.

2. Insert the original Takeed*Break!
Crosswrords disk in a floppy disk drive,

3. In the Program Manager, select Run
from the File pulldown menu.

4. 'l'ﬂ:u:' the letter of the ﬂup[u'_r iisk drive
containing the Crosswords disketie fol-
loweed h:-. the command “ASETUP™ then
press | Enter| or chick the [OK | buiion.

i"..'::mlph:': AMSETLUP [Enter)

5. The Setup program will ask you into
which hard drive and e-1||uli1'|=*~|"rur:r Vil

wish 1o plm'r' the Crossirords e,

6. After vou have indicated which hard
1|Tl-"|-1' L wount to 'i[l'-'rllll ||||' AL L. lIIII\
[OK]. The program will check for suffi-
cient storage space. If space is available.
the installation process will take from one
LN Fi.\'!" prntes '!II'"lJI"II'Zl.i]I:'.f Iil'lﬂr:l rl::H' hlll'l"ﬂl.

|..|f :I.'I!llll' CLHELE mer .il[Hi ll]l["l] 1|]'Zi'l- .

¥ . Now vou are ready 1o play.
Double-click on the Srerra
gronp icon. then double-
click on the
{“rosswords icon,
Enjoy the

|
s .
LR Y L

The File menu

Open

=elect 1_}|n'|| I |_lL'_I:'. i MW FII]I]"'I:'. IT you
are currently playving a puzzle when you
select the Open command, you will be
asked il vou wish o save the curvent pu-

?ll' }ll‘fﬂﬂ‘ E(hHI]i.IllL' H OTIEW e,

From the Puzzle Selection window you
can select puzeles of varying size and dif-
ficuliv. Seroll through the list of available
puzzles and highlight the one vou wish 1o
plav. Click on the Play Blank Puzzle
button on the bottom of the window o
select the highlighted choice. To restore a
puzzle saved in progress elick on the Play
Restored Puzzle button.

Clear/Restart
Restarts a puzzle from the beginning.
Warning!! This will completely clear all

viur Work in progress !

Hestore
Choose Restore from the File menn to

|'|I:|1.' a pre viously saved szrlr.

Save

maves a puzzle in progress,

Print

Prints a puzzle in progress. Crossivords
requuires a graphics-capable. Windows-
compatible printer such as a dot-matrix.
thermal. ink jet or laser printer. Mo -

2r'=1!r]‘:jr.=- Fu"mlrr-'- will not work.

Exut

Exits the game to Windows,



The Options menu
.I.ll‘l' “ll-lil‘.lllﬁ TR irll"llll!l‘!—- ~u'1'1'ru| [l'll-
tures to tailor Crosswords to vour prefer-

FMCES,

Undo

Undo will restore the current word to
what it was before you started tvping. No
scoring penalties will be deducted if vou
select Undo and choose a different word,

Colors

Customize the colors of vour puzzle
sereen. There are several different tiles
with rurn*ﬁfﬂjllnlirlg Across and Down
placards,

Autocheck Word

Autocheck gives the novice-puzzler im-
mediate notilication of whether an an-
swer is correct. I an answer is wrong, the
(RN | tl"ll r "ﬁ-'l”. CTHs" 'I'I'I'F' 'il'lll"l'l'l'l"l""l"T ANMEW™er
and allow you to iry again. If an answer is
correct, the word-highlight bar will ad-
vance to the next incomplete or wrong
answer. Note: Scoring options and sound
effects are disabled when Autocheck is
turned off.

Auto-Letter Advance

Auto-Letter Advance selects the nexi
blank letter when vou are typing in an
answer. This allows vou 1o tvpe in words
without retyping already solved letters,

Interconnecting Clue Highlight

This feature highlights entries in the clue
list related to the current leter position.
For example. if the third lerrer of

1-Across 1= hichlishied and this also
happens 1o be the first letter of 3-Down,
the 1-Aeross and 3-Down clues will both
be highlighted in the clue lisis.

Clock

]'I Il I.['d glillll‘!llﬂ':l - I"Il," Il,lrl'l‘l"'l,l O O UIT.
Completion time is always displayed dur-
ing the congratulations screen, regardless
of the clock serring.

256 Color Artwork

Select between standard 16-color artwork
and enhanced 20d-color artwaork for
computers that can display 256 color
graphics. You must restart the game from
Windows to see changes to the graphics
modle.

Wanda's Head

Hides the animation of Wanda the Word
Fairv's head which appears at the top of
vour screen, The option is on if a check
mark Appears bussiale it.

Wanda's Placards
Hﬂ‘lﬂ"l th‘l‘l]le' 'I'II].HIZ"H ri |..‘i- “'l'i'i I"h TI'IH}' I'I!’
LU0 b H'I.]!ﬂ'[ IT!I'I-iJ,]lr,' l'ur |||r_' "A'Urli L ]| ".'!._!'UI]-
ment with this option. An example of W’“ :
placards will appear as the heading [« o

the Display Score option.

Animations
Turn off the congramlanons animaris it :
displaved when vou complete a puzzled 80
You will still get the congratalations mes-

:'-ii'lgl:". ql”ll'.""'. HI"I SO Ill'l'th]l PRI '“'I'H"TI

vinl riIl]I:-!] H FPIII?.'I!‘-



GAMEFLAY

The Skill menv

The Skill menu offers three levels of
crossword challenge. The level you
choose adjusts “handicap™ features to
mike vour Crogswords experience more

challenging.

Apprentice
This is the easiest skill level. Hints and
Autocheck are available w you,

Puzzler

As a Puzzler, vou don't have aceess 1o
Hints. You do have the option to use
Autocheck.

Fanahic

For Fanatic puzzlers, Hinis and Auto-
check are not available. Purisis can mea-
sure their }H:rsmlu] best by Chﬁ:ki‘llg the
Wrong Answer Penalty score when
completing the puzzle.

The Hints menv

At the Apprentice skill level. vou have
access 1o six types of hints. You can re-
veal a random Single Letter, Single
Consonant, Single Vowel: or you can
reveal All the vowels or consonamis. 1f
you are really stumped, you can select
Whole Word and get on with the rest
of the puzzle.

The Score menu

Display Score

Displays your current score, The score
display shows total correct words, score
information. penalties associated with
wrong answers and hints, and the adjust-
ed score and percentage of puzzle com-
pleted. Note: The Adjusted Score is
different from the Total Score shown on
the congratulations screen. The Adjusted
Score does not include time bonuses or
penalties.

Irll'll“ f[]]l['l"ﬂ."i I'I.H I'H]:]].f' I'l"l'lll'l"!-rf' Mnis A h‘!"l"ﬂiﬁ =
down of how yvour score is computed in
TakeeA*Break! Crosswords,

Puzzle Difficulty

Autocheck ON:  Fosy Med. Hard
Correct Answer +100 +200 +300
Wrong Answer 25 =50 <75
Single Letter Hints 15 -30 45
Singhr Vowsl Hink 20 -40 80
Single Consonant Hinks~ -10. =20 -
All Vowels Hints 50 -120 -180
All Consonants Hints ~~~ -40  -80 -120
Whole Word Hints 100 -200 -300
Early Finish Bonus

[per minuke) +1000 +2000 +3000
Late Finish Penalty

(per minute] -500 -1000 -1500




Avtocheck OFF: Eosy Med. Hord
Correct Answer +200 +400 +600
Wrong Answer -50 -100 -150
Einglnl.eﬁm'Hirﬂs“ § --30 40 90
Single Vowel Hints .40 -80 -120
Single ConsonantHints ~ -20  -40 -60
All Vowels Hinis -120 -240 -360

Ml-énnmnmh Hints -80 -160 -240

Whole Word Hins 200 -400 -600

Early Finish Bonus

|per minute) +2000 +4000 +6000
Late Finish Penally _

(per minute) -1000 -2000 -3000
Scoring ON/OFF

Turns scoring on or off. Scoring is not
available if Autocheck is rurned off be-
cause displaving the score would indicate
a correct or incorrect answer, However, if
scoring is turmed off vou siill will be able
to see the final score in the congratula-
LOns message.

The Sound menwv

Music and Sound Effects

Turn music or sound effects on or off by
selecting Music or Sound Effects (rom
the sound menu. An oprion is on if a
check mark appears beside it. Refer to the
Music & Sound Effects section on page 15
ar the README file on disk for muore

information.

Roland Enhanced Music

Turns Holand Enhanced Music on or
off. Refer to the README file on disk
for more detailed information.

The Pause/Hide menu

Pause vour game in progress while
“hiding” (minimizing) your game screen
toa Windows Deskrop icon. Select the
Pause/Hide option from the Pause/
Ili‘l]i' I"]I].[]“'l'l'l. ITNCTINL, O f']!.l'h i Thl"
minimize burton on the upper right
hand corner of the Takes4sBreak!
Crossirords window (indicated by a
downward pointed triangle ).

You can choose one ol four dilferent
icons to display when the game is
pansed, These include two “fun” icons
{{ jrl]bb“"ﬂl‘[i.".- H.Il[i l“-IH.IZI [hij- lIIIlI aiar "Il"!E-!':-
conspicuons” icons entitled file (unti-
tled) and Worksheet.

Congratulations!

After you complete a puzele, a congratu-
lations message appears that displavs a
famons quote, vour final scoring infor-
mation, and an animation if you choose.
You may view it again by selecting the
Display Congratulation Sereen option
[rom the Congratulations menu.



GAMEPLAY

Mouse and Keyboard Controls
You can play TakesdeBreak! Crosswords
with the kevboard only or with a combina-
tion of mouse and kevhoard controls,

Mouse Controls

When cursor is over puzsie:

Righi mouse buiton selects
cursor direction (across or down ).

Left mouse button is clicked on the
desired puzzle squares 1o select a par-
ticular word, and 1o enter an answer,

When cursor is over Across and Down
clue list bores:

Left mouse button selects a new
clue. You may also seroll through clue

choices with the seroll bar.

Note: The squares of a selected word are
highljghtw] m :.'E*qu', with the curremt let-

her s sipuare highlighned in red.

The active elue list [ Aeross or Down | has
a white background with blue letters and a
dark red highlight bar indicating the cur-
rent selection. The inactive list of clues ap-
pears in a darker color,

Keyboard Commands

Most menus and options can be accessed
by pressing [ALT] plus the underlined
letter in the menus.

Tab

Switches berween Across and Down
clues {as indicated by the current letter
SOJUATE |

‘ Enter i

Enters current guess and advanees vou to
the pext clue, Note: 1T Autocheck is se-
]'I'l"l I"d 'Il'i mi “'i]l IH" ﬂ.l:]:".'l'l]'“'l‘ll Tk EI]"' next iII'

COrTect OF Heo F}tt'H' "A'I.I'I"l'l.

ET.H'T!"\- current z'.ﬂ]'l"'h!‘"i il "] H'I\-ﬂ.ll‘.'“.‘:‘ ‘_I-"':“t to
the previons clhue. Vote: If Autocheck is
sl v will e ndvanced to the next

incorrect or incomplete word.

: Fj {}IH"IIH Ttll' IlI]IIIl' Hf]i‘l'lil kLl 'I'I-'il].l Il]"!'
u in order to choose a new puzzle.

I F3 I Pause/Hide the game.

; A Z | |'1.|:|I1"r:-. ]'"H!’Jl[lﬁ“'l"l" illl ] Ttll'
u current letter hox,

ll|n.l'_ilq'E'.‘ ﬂll CUTs40r I-li,l,":r'h [Ellll,l Il"l!'.h:ﬂi]lll"l"j

retain their wsnal funetions.



Music & Sound Effects

Impaortant Note! Music & Sound effects
are omly available with Windows 3.1 or
higher, or with Windows 3.0 with

Muliimedia Exiensions,

Please reler 1o the README file ineluded
on the Crogsewords disk Tor detailed
information on how 1o configure sound
and music for the best possible resules on
VOUr SYSlem.

High Performance Tips
TakesAsBreak! Crossiords contains
many state-of-the-art features that re-
fuire extra memory and computer pro-
cessing time. [f vou wish 1o reduce the
memory usage or increase the speed of
TakesAoBreak! Crosswords, vou may
want to disable some features that are
particularly demanding of computer
power, These features inclhade:

256 color artwork (il available)

Interconnecting Clue Highlight

Animations

Music & Sound Effects

Augarde. Tony. The Oxford Guide 1o
Word Games. Oxford University Press,
Orxford, I".nlt_l|:1||rt- 14984,

Daniels. Vera., The Experts” Book of
Crosstword Puzzle Making, Doubleday

gl f_.'urllpullg.'.. Ine. Garden Ciry, New
York. 1976.

Ll Norman. flow to Solve Crossword
Pirzzles. Wehster's Red Seal Publicanons

Ine. New York. 1974,

hennedy, . Michael =40 million
Americans grapple with *7 across™”

San Jose Mercury News 21, March 1992,
s ‘ !-H

Kurzban, Stan and Rosen, Mel, The
Complete Cruciverbalist; Or How to Solee
Crossword Puzzles for Fun and Profit.
Litton Educational Publishing Ine. New

York. 1981.
Millington, Roger. Crossiword Puzzies;

Their History and Their Cult. Thomas
“elson Publishers. New York. 1974,

“1942-1992 Fifty Years of Crosswords,”
February 16, 1992, New York Times

Sunday Magazine,
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Technical Help

Technical assistance is only & phone call away. In the
L=, call (209) 683-B989 [or convenient, person-io-
person service, or il vou prefer, vou may requesi
assistance by mail. If you choose to write 1o us with
vour request, please state vour computer tvpe and the
nature of your problem.

eall or write:

Sicrra

Technical Support

I*.0). Box 800, Coarsegald.

CA D361 4-0800 LS A,

(200 GE3-BU980 = fax (209) Hi3-3033

Ohur Ewropean castomers may call or write our 1K,
affice:

Sierra On-Line Limited

Lnit 2. Technology Centre.

station Road,

Theale Berkshire RGT 4AA United Kingdom
0734-303171

Replacement Disk

It vour findd that vou need to send for replacement
diskeites, send the original disk #1 1o

Sierra

.0, Box 485, Coarsegold.

CA 9360 14-0485 [71.5.A.

'I. Ilia; R-r-!u (|

Be sure 10 include a note stating your companer rype,
and the size of diskette vou need (5,257 or 3.57). We
will gladly replace your program free of charge for the
[irst 90 days of ownership (please enclose a copy of
NORLE daned sales nﬁrrilpl with YORLLF ﬁ‘-l’{u-n‘ail}. Alier ™M)
days there is & 310,00 charge for 5,257 or 3.5°
diskertes,

Sierra BBS

If you have a modem, you may aceess the Sierra BBS
for technical assistance. downloadable demos. caralogs.
ete. (parameters: 30001 200/2400/9%00 baud up to
V. 42bis, N, B, 1).

In the U5, call {209) 6H3-4463.

In the UK. call 07534-304227.

Customer Service

Call or write the Customer ':iup}mrr rh|mrr||1u1r with
inquiries abour general game information., company
policy, back orders, returned or defective merchandise.
Sicrrn

Customer Support

PO Box 600, Coarsegold,

CA 936140000

IT 15 ILLEGAL TO MAKE UNAUTHORIZED COPIES OF THIS SOFTWARE
This software is protected ander federal copyright law. It is illegal 10 make or distribute copics of this software excepe
to make a backup copy for archival purposes only. Duplication of this software for any other reason including for
sale. loan, rental or gift is a federal crime. Penalties include fines as high as S500000 and jail terms of up to five vears.

&) SIERRA

as a member of the Software Publishers Association (SPA)L supports the ndustry™s effort 1o fight the illegal copying of
personal compaiter software,

Report Copyright Violations To:

SPA, 1101 Connecticut Avenue, NW, Suoe D01
Washington, DO 200556

Limited Warranty Notice
The publisher ol this soliware wanis vour continued business. If vou [l ot the enclosed product registration card and
return it to us, you are covered by our warranty, 1§ your softeare should fail within 90 days of purchase, return it 1o
vour dealer or 1|1rn't|1.r o s, and we will rrpluu 1] frn After 0 days, enclose 510 for 5. .!.: or 3.5 disks and retum
the software directly 10 us. Sorry, withoun the registration card vou are not covered by the warranty, This warranty
gives you specific begal righis, and vou may also have other rights which vary from state 1o state.
t Notice
This manual, and the sofiware described in this manual. are copyrighted. All nghis are reserved. Mo part of this manual

or the described soliware may be copied, reproduced, translated or reduced 10 any electronic medium or machine-
readable form withour the prior written consent of Sierra On-Line, Ine_. PO Box -1-H.1. Coarsegaold, CA %014,




